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1. Solving a Vision Problem

A typical vision-based application follows these steps:

1. Acquire images

External images must be stored in a host PC memory buffer with a known address. They must be
linked to the Open eVision image object with parameters containing the address and pitch (32
bytes default) of the buffer, and the width and height of the image.

For details see Image Construction and Memory Allocation.

To optimize resolution and repeatability, the area of interest should occupy most of the field of
view, and the targeted inspection equipment should be simulated as accurately as possible, with
realistic lighting.

You should create two series of images:

m objects without defects (accepted by the inspection process) in all situations (such as
unstable lighting conditions and movement freedom).

m objects with unacceptable defects (to be rejected by the inspection process).

Use Open eVision Libraries to process the images:

2. Pre-process images

Reduce defects or enhance properties (such as contrast between the object of interest and
background).

Bt
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3. Locate objects of interest

Locate the area of interest using techniques such as segmentation, edge detection or pattern
matching.
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4. Analyse your findings

EasyObject measures unknown shapes
EasyGauge returns accurate measurements of known objects
Easylmage provides statistical parameters

Measurements are performed locally so quantify the shape of objects geometrically, defects can
be related to abnormal gray-level values.
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5. Optimize your application

Your solution must reliably separate good images from bad images by comparing ROI features to
assess quality, detect defects, and recognize and sort objects.
If it can't, repeat steps 2 and 3 to improve your set of features.

Develop thread safe applications

Open eVision supports simultaneous execution by multiple (unlimited) threads on the same CPU,
but data can only be accessed by one thread at a time

So independent tasks can execute simultaneously in your application, but each bit of shared
data must be controlled by a separate task.

Rules for Thread-Safe Developments

The following rules avoid data corruption, crashes and misbehaving programs.
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Thread-safe basic types classes

Basic pixel structures

EColor, EPeak, EISH, ELAB, ELCH,
ELSH, ELUV, EBW1, EBWS,
EBW8Path, EBW16, EBW16Path,
EBW32, EC15, EC16, EC24, EC24A,
EC24Path, EPath, ERGB, ERGBColor,
EVSH, EXYZ, EYIQ, EYSH, EYUV,
EDepth8, EDepth16 and EDepth32f

Pixel collection classes

EColorLookup, EPseudoColorLookup,
EPeakVector, EBW8Vector,
EBWHistogramVector,
EBW8PathVector, EBW16PathVector,
EBW16Vector, EBW32Vector,
EC24Vector, EPathVector,
EColorVector, EColorLookup and
EC24PathVector

Image classes

ElmageBW1, EImageBWS8,
ElmageBW16, EImageBW32,
ElmageC15, ElmageC16, EImageC24
and ElmageC24A

Depth map classes

EDepthMap8, EDepthMap16 and
EDepthMap32f

No restrictions on
read-only access.

No restrictions on
read-only access.

No restrictions on
read-only access.

No

A single instance may not be
modified by several threads.

If a thread is modifying an
instance, no other thread can
access it.

A single instance may not be
modified by several threads.

If a thread is modifying an
instance, no other thread can
access it.

A single instance may not be
modified by several threads.

If a thread is modifying an
instance, no other thread can
access it.
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Point cloud classes

E3DPointCloud

ROI classes

EROIBW1, EROIBWS8, EROIBW16,
EROIBW32, EROIC15, EROIC1S6,

EROIC24 and EROIC24A

No restrictions on
read-only access.

No restrictions on
read-only access.

EDepthMapROI8, EDepthMapROI16

and EDepthMapROI32f

Thread-safe library classes

A single instance may not be
modified by several threads.

If a thread is modifying an
instance, no other thread can
access it.

A single instance may not be
modified by several threads.

If a thread is modifying an
instance, no other thread can
access it.

Different ROI can be added or
removed from an image or
moved event if their parent
image is the same.
Consequently, different threads
can work on different areas of
an image possibly changing in
position and size during the
process.

Easylmage and EasyColor

EasyObject

EasyMatch, EasyFind,
EasyQRCode and EasyOCR2

EMatcher, EMatchPosition,
EPatternFinder and
EFoundPattern

EasyGauge and Shape
subclasses

Static methods from this class
(provided threading rules
applying to their arguments
are not broken).

No

No

A single instance cannot be
accessed from several
threads.

Search field (read-only) can
be shared by different
objects.

Can be attached, moved or
removed from different
threads, even in the same
hierarchy.

A single instance must not
be used by different
threads.
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Gauging classes

(EPointGauge, ELineGauge,

ERectangleGauge,

ECircleGauge, EWedgeGauge),

EWorldShape and
EFrameShape)

Basic geometric classes
(EFrame, EPoint, ECircle,
ELine, ERectangle and
EWedge)

Gauging classes measuring
and processing operations

EWorldShape

EasyOCR, EasyOCV and
EasyBarCode

EOCR, EOCV, EOCVChar,
EOCVText and EBarCode

EChecker

EasyMatrixCode
EMatrixCodeReader

Report errors

May be executed in different

threads with no blocking even

if these gauges perform their
measuring operations in the
same image.

Multiple CPU usage will be
optimal.

Different instances may be
created and used from
different threads.

Different instances may be
used from different threads.

Multiple CPU usage will be
optimal.

Recommendations Restrictions

Can be accessed from
different threads provided
that an instance is not used
by two different threads
simultaneously.

A single instance cannot be
read / modified by two
threads .

A single instance cannot be
read / modified from
different threads.

A single instance cannot be
accessed from several
threads.

A single instance cannot be
used by several threads.

A single MatrixCode cannot
be used in multiple threads.

When an Open eVision function fails, an exception is thrown which contains an error code and a
description. To catch a potential exception, the function call is included in a try-catch block.

Measure execution times

Timing a particular piece of code is achieved simply with start and stop operations:

m Start timing: Easy::.StartTiming

m Stop timing: Easy::.StopTiming
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m Clock resolution: Easy::.TrueTimingResolution

help is available:

Open eVision Studio

Speeds up and automates the creation of a solution. You can test the functions to find
appropriate parameter values, and generate code of your operations to copy and paste into
prototype applications.

Open eVision examples
Euresys download area contains:

m sample projects: how to use Open eVision libraries with a particular IDE.

m sample application programs: how to combine Open eVision functions and libraries in a
variety of combinations and applications.


http://www.euresys.com/downloadarea/Download.asp
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2. Discovering Open eVision

Libraries

The Open eVision libraries are a set of powerful image processing tools, tailored for use in
computer vision applications. They cover most state-of-the-art techniques in digital image
processing, from classical algorithms to advanced solutions ready-made for specific tasks.

Even though many of the available tools are designed to be self-consistent and easy to use, the
advanced user should find everything he needs to build his own workflow by combining the
numerous building blocks provided.

Open eVision is made of a set of C++, ActiveX and .NET classes designed to be integrated into
your application. The libraries are in no way a closed solution and do require to be integrated in
your own application, leaving you all the freedom to deal with all other aspects of the
automation not related to image processing.

Foundations

m Basic Types and Operations contains the definition of fundamental objects , types, classes and
functions used in all Open eVision components.

m Easy3D contains a set of tools for solving computer vision problem using 3D acquisition and
processing.

Preprocessing

m Easylmage contains gray-level image processing functions that improve image quality and
contrast between background and objects of interest as well as linear and non-linear
filtering,and geometric transformations.

m EasyColor contains color image processing functions that efficiently convert images between
several color systems.

Blob inspection

m EasyObject obtains information about distinct objects (blob analysis), identifies them using
connected component labeling, then sorts them and selects with them respect to their
geometric features.

m EasyObject 2 contains advanced blob detection and analysis tools.

Pattern matching

m EasyMatch locates patterns in an image based on a pixel-by-pixel comparison with a
reference pattern or template. It can be used for image registration or component placement
inspection.
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m EasyFind locates patterns in an image based on a geometrical model from a reference pattern
or template. Compared to EasyMatch, it is computationally fast,robust against noise,
occlusion, blurring and illumination variations.

2D measurement

m EasyGauge assesses dimensions of objects to sub-pixel precision, detects edges, locates
points and fits geometric models. EasyGauge can measure in physical units (mm, inch, ...)
instead of pixels if the field of view is calibrated.

Mark-Inspection Libraries

m EasyOCR performs optical character recognition. It can be used for reading serial numbers or
printed labels.

m EasyOCR2 contains advanced optical character recognition functions.

m EasyOCV checks the print quality of labels against a template. EasyOCV can inspect the
global image or independent shapes. It can detect issues with low contrast, misalignment,
scratches or incorrect markings.

m Echecker creates a Golden template and inspects images. It uses EasyOCV library functions.
m EasyBarCode reads bar codes.

m EasyMatrixCode and EasyMatrixCode2 read data matrix codes.

m EasyQRCode detects and decodes QR codes.

Image statistics

m Easylmage statistics contains tools for quantifying image focus, sliding window statistics and
histogram analysis.
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3. Dealing with Pixel Containers

and Files

3.1. Pixel Container Definition

Images

Open eVision image objects contain image data that represents rectangular images.

Each image object has a data buffer, accessible via a pointer, where pixel values are stored
contiguously, row by row.
o— Image width = number of pixels per line
1 —
O

number of lines

Image height

Visible image

Image main parameters

An Open eVision image object has a rectangular array of pixels characterized by EBaseROT
parameters .

m Width is the number of columns (pixels) per row of the image.

m Height is the number of rows of the image. (Maximum width / height is 32,767 (21°-1) in Open
eVision 32-bit, and 2,147,483,647 (231-1) in Open eVision 64-bit.)

m Size isthe width and height.

The Plane parameter contains the number of color components. Gray-level images = 1. Color
images = 3.
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Classes

Image and ROI classes derive from abstract class EBaseROT and inherit all its properties.

EBaseROI
EROIBW1
ElmageBW1

EROL...

Elmage...

EROIC24A

ElmageC24A

Depth maps

A depth map is way to represent a 3D object using a 2D grayscale image, each pixel in the image
representing a 3D point.

The pixel coordinates are the representation of the X and Y coordinates of the point while the
grayscale value of the pixel is a representation of the Z coordinate of the point.

Point clouds

A point cloud (https://en.wikipedia.org/wiki/Point_cloud) is an unstructured set of 3D points
representing discrete positions on the surface of an object.
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3D point clouds are produced by various 3D scanning techniques, such as Laser Triangulation,
Time of Flight or Structured Lighting.

3.2. Pixel Container Types

Images

Several image types are supported according to their pixel types: black and white, gray levels,

color, etc.

Easy.GetBestMatchinglmageType returns the best matching image type for a given file on disk.

BW1

BW8

BW16

BW32

C15

1-bit black and white images (8 pixels

are stored in 1 byte)

8-bit grayscale images (each pixel is

stored in 1 byte)

16-bit grayscale images (each pixel is

stored in 2 bytes)

32-bit grayscale images (each pixel is

stored in 4 bytes)

15-bit color images (each pixel is stored

in 2 bytes).

Compatible with Microsoft® Windows
RGB15 color images and MultiCam

RGB15 format.

EImageBW1

EImageBWS

EImageBW16

EImageBW32

EImageCl5
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16-bit color images (each pixel is stored
in 2 bytes).
Cl6 Compatible with Microsoft® Windows EImageCl6
RGB16 color images and MultiCam
RGB16 format.

C24 images store 24-bit color images
(each pixel is stored in 3 bytes).
C24 Compatible with Microsoft® Windows EImageC24
RGB24 color images and MultiCam
RGB24 format.

C24A images store 32-bit color images
(each pixel is stored in 4 bytes).

C24A Compatible with Microsoft® Windows EImageC24A
RGB32 color images and MultiCam
RGB32 format.
Depth Maps

8 and 16-bit depth map values are stored in buffers compatible with the 2D Open eVision images.

8-bit depth map (each pixel is stored in

EDepthMap8
EDepth8 1 byte as an integer) ceee
EDepth16 .16-b|t depth ma.p (each‘ pixel is stored EDepthMapl6
in 2 bytes as a fixed point)
EDepth32f ;%2-b|t depth map (each pixel is stored EDepthMap32 £
in 4 bytes as a float)
Point Clouds
Point Cloud Set of points coordinates (stored as T —

float)

3.3. Supported Image File Types

BMP Uncompressed image data format (Windows Bitmap Format)

Lossy data compression standard issued by the Joint Photographic Expert Group

JPEG registered as ISO/IEC 10918-1. Compression irretrievably looses quality.

JFIF JPEG File Interchange Format
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Data compression standard issued by the Joint Photographic Expert Group
registered as ISO/IEC 15444-1 and ISO/IEC 15444-2. Open eVision supports only

JPEG- lossy compression format, file format and code stream variants.
2000 - code stream describes the image samples.
- file format includes meta-information such as image resolution and color
space.
PNG Lossless data compression method (Portable Network Graphics).
- Euresys proprietary image file format obtained from the serialization of Open
Serialized —o'o>Ys Proprietary image i I ratizati P

eVision image objects.

Tag Image File Format is currently controlled by Adobe Systems and uses the
LibTIFF third-party library to process images written for 5.0 or 6.0 TIFF
specification.

TIFF
File save operations are lossless and use CCITT 1D compression for 1-bit binary

pixel types and LZW compression for all others.

File load operations support all TIFF variants listed in the LibTIFF specification.

3.4. Pixel and File Types Compatibility

Depth map to image conversion

For a 8- and 16-bit depth maps, the AsTmage () method returns a compatible image object
(respectively ETmageBwW8 and EImageBW16) that can be used with Open eVision’s 2D processing
features.

Pixel and file types compatibility

Pixel access

The recommended method to access pixels is to use setImagePtr and Get ImagePtr to embed
the image buffer access in your own code. See also Image Construction and Memory Allocation
and Retrieving Pixel Values.

Use of the following methods should be limited because of the overhead incurred by each
function call:

Direct access

EROTBWS: : .GetPixel and SetPixel methods are implemented in all image and ROI classes to
read and write a pixel value at given coordinates. To scan all pixels of an image, you could run a
double loop on the X and Y coordinates and use GetPixel or SetPixel each iteration, but this
is not recommended.
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TIP

For performance reasons, these accessors should not be used when a
significant number of pixel needs to be processed. When that is the case,
retrieving the internal buffer pointer using GetBufferpPtr () and iterating
on the pointer is recommended.

- J

Quick Access to BWS8 Pixels

In BW8 images, a call to EBW8PixelAccessor::.GetPixel or SetPixel will be faster than a
direct EROIBWS: : .GetPixel Or SetPixel.

Supported structures

m EBWI1, EBW8, EBW32
m EC15 (*), EC16 (¥), EC24 (%)
®m EC24A

B EDepth8, EDepthl6, EDepth32f,
(*) These formats support RGB15 (5-5-5 bit packing), RGB16 (5-6-5 bit packing) and RGB32 (RGB +

alpha channel) but they must be converted to/from EC24 using EasyImage: : .Convert before
any processing.

e N

NOTE

Transition with versions prior to eVision 6.5 should be seamless: image pixel
types were defined using typedef of integral types, pixel values were treated
as unsigned numbers and implicit conversion to/from previous types is
provided.

(. J

Pixel and File Type compatibility during Load or Save operations

BW1 Ok N/A N/A Ok Ok Ok

BW8 Ok Ok Ok Ok Ok Ok
BW16 N/A  N/A Ok Ok Ok (***) Ok
BW32 N/A  N/A N/A N/A Ok (***) Ok
C15 Ok Ok (**) Ok (**) ok (**) ok (**) Ok
C16 ok ok (**) Ok (**) Ok (**) Ok (**) Ok
C24 Ok Ok Ok Ok ok (**) Ok
C24A Ok N/A N/A Ok N/A Ok
Depth8 Ok Ok Ok Ok Ok Ok
Depth16 N/A  N/A Ok Ok Ok (***) Ok
Depth32f N/A  N/A N/A N/A N/A o
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N/A: Not supported. An exception occurs if you use the combination.

Ok: Image integrity is preserved with no data loss (apart from JPEG and JPEG2000, lossy
compression).

(**) C15 and C16 formats are automatically converted into C24 during the save operation.

(***) BW16 and BW32 are not supported by Baseline TIFF readers.

3.5. Color Types

EISH: Intensity, Saturation, Hue color system.

ELAB: CIE Lightness, a*, b* color system.

ELCH: Lightness, Chroma, Hue color system.

ELSH: Lightness, Saturation, Hue color system.

ELUV: CIE Lightness, u*, v* color system.

ERGB: NTSC/PAL/SMPTE Red, Green, Blue color system.
EVSH: Value, Saturation, Hue color system.

EXYZ: CIE XYZ color system.

EYIQ: CCIR Luma, Inphase, Quadrature color system.
EYSH: CCIR Luma, Saturation, Hue color system.

EYUV: CCIR Luma, U Chroma, V Chroma color system.
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1. Selecting your Programming

Language

When you start Open eVision Studio for the first time, the following welcome screen is displayed:

Choose your preferred programming language: ® c++ (O c# (O Visual Basic

T X

Load an image Load a sample image Load a recently
opened image
] bo nok show at startup [ o=

[

. Select your programming language.

@ TIP

Your selection is saved and your programming language will be automatically
selected next time you start Open eVision Studio.

_Vl NOTE

When you change your programming language, any script present in the
scripting window is automatically deleted and the window content is reset.

2. Click on one of the Load buttons to already load one or several images for later processing.

w

. Check the Do not show at startup box to hide this welcome screen next time you start Open
eVision Studio.

TIP
To access this welcome screen at any time, and change this setting, go to the
Help > Welcome Screen menu.
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2. Navigat

ng the Interrace

X : ' e — 5 >
Imege Script _Easylmage EasyColor EasyObject EasyGauge EssyMatch Easyfind EasyOCR EasyOCR2 EasyOCV EasyBarCode EasyMatriCode EasyORCade View Window He|p|(1[
R EN R EENEE T LT IR EEES)

= .
@ CEEsert : ] (g aialmages fcAProgrem Fies poshEurese\Open o, [0 | EL]iEE]
vector<EFocundPattern> EPatternFinderlFoundPatterns; // A =%
IFcundPattern instances
EWorldShape Eﬁurl:i;h;;e;;m: “'v-i.:;;d;;-:;;e instance e N ]l
EOCRZ EOCRZ1; // EZOCRZ inst = B " EMatcher (EMatcher2) D Instance(s) Fo... - X
EPatternfinder E i 2: // EPatternFinder instan
vector<EFcundPattern: EPatternFinderzFoundPatterns; // Leaming  Matching Dont Care Areas
ZFoundFattern instances
BSinas Brueinace; f Tiahee itstanca @ S Inage Mo
~ Fitering | Urifomn

EBWEBImage3.Load ("C:\\Pr Files (x8£€)\\Euresys\\Open ==
eVision Z.2\\Sample Images\ rixCode\\Hard Mxc
VHE_ ge;.SetS:\.za(Elz, 512); @

/{ Make image black

EasyImage::Oper (ERrithmeticLogicOperation Copy, EBWE(0), 1 Pixel Dimensions
&Eéw;;:;i:;;;il.aadt"::‘.\!::E:am Files (x86)\\Z : Width
;:s Z\\Sample Images\\EasyBarCode\\B ~ Height

rnFinderl.SetInterpolateitrue); . _‘2- J&

EPatternFinderZ.SetInterpolateitrus); Load..,

- - [ Save s,
@ @ [ team || PRests |[ Gose |
| [Gper | Dictect T Eroonime | B | milie WizT3e [v] 3 [wadz] Warld ¥ |Gy | 40 lsn -] |
EBWSImage3 (C:\Program Files (x36)\Euresys\Open eVision 2.2\Sample Images\EasyMatrixCode\Hard Mxc\Hard2 tif) NUM Tug, 31 October 2017 10:28 @

Open eVision Studio graphical user interface (GUI) is organized as follows:

1. The main menu bar gives you access to the functions and tools of all libraries.

p

TIP
Open eVision Studio does not require any license and allows you to test all
libraries. Of course, if you copy code from Open eVision Studio in your own
application but you do not have the required license, you will receive a
"missing license" error at run-time.
(& J

2. The main toolbar gives you a quick access to main Open eVision objects such as images,
shapes, gauges, bar codes, matrix codes...

3. The script window displays the code, in the programming language you selected,
corresponding to the actions you perform in Open eVision Studio. You can save or copy this
code in your own application at any time.

4. The image windows display the open images that you can process using the libraries and
tools.

5. The tool windows enable you to easily configure all the available tools. The corresponding
settings are automatically added in the script window for easy reuse.
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TIP
Most tool windows are floating and you can easily move them outside the
Open eVision Studio main window to make a better use of your screen size.

6. The execution time bar displays the precise time taken for the execution of the selected
functions (measured in milliseconds or microseconds) on your computer. This accurate
measurement helps you to evaluate the performance of your application.

7. The color toolbar displays current information such as the X and Y coordinates of the cursor
on an image and the corresponding pixel value.

8. The status bar displays general information about the application such as the active image file
path...
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3. Running Tools on Images

3.1. Step 1: Selecting a Tool

Usually the first step, when using Open eVision Studio, is to select the library and the tool you
want to use on your image.

To do so:
1. In the main menu bar, click on the library you want to use.

2. Click on the tool you want to use.

@ TIP

All libraries (except Easylmage, EasyColor and EasyGauge) expose only one
tool named New Xxx Tool. Some of these libraries also expose additional
functions.

3. In the dialog box, enter a Variable name for the variable that is automatically created and
that will contain the result of the processing.

New EQRCode

Wariable name

Example of variable creation dialog box for EasyQRCode

4. Click OK.

The selected tool dialog box opens.
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|81 EQRCode (EORCodef) — x
Read  Advanced

Source Image Resuts

Stream Parts

Encoding

Display As

Data

Detection Trade Off
] Is Reliable

Speed Balanced Reliabiity 1o I:|
Custom Trade OF ] Vession |:|
Urreliable GRCode - |:|
Show 0 Unused Eror Comection ||

Coding

Application Indicator

e ] Co=]

Example of variable creation dialog box for EasyQRCode

The next step is "Step 2: Opening an Image" below.

3.2. 5tep 2: Opening an Image

Once you have selected your library and your tool, you need to open an image to apply this tool.
In the Source Image area of the selected tool dialog box:
1. Open an image:
o Click on the Open an Image button and select one or several (using SHIFT and CTRL)
images on your computer.

o Or select one of the images (or one of the ROIs, if any) already open in the drop-down list.

NOTE
You can select only images with an appropriate file format (JPG, PNG, TIFF or
BMP) and in 8- and/or 24-bit depending on the library.

Source Image

| EBWBImage11 vJ

2. If you selected several images, activate one with the Load Previous or Load Next
buttons.
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The tool is automatically applied on any loaded image and, at this stage, the result is displayed
based on the tool default settings.

The next step is "Step 3: Managing ROIs" below.

3.3. Step 3: Managing ROIs

In some cases, most often to decrease the processing time or to single-out the object you want
to read, you do not want to process the whole image but only one or several well defined
rectangular parts of this image, or ROIs (Regions Of Interest).

In Open eVision, ROIs are attached to an image and exist only as long as the
parent image is available.

@TIP

Creating a ROI

1. Open the image:

o If the image is already open, activate the corresponding image window.

o If the image is not open yet, go to the main menu: Image > Open... to open one.
2. To create an ROI, go to the main menu: Image > ROl Management....

The ROI Management window is displayed as illustrated below.

Roi Management.. — X

= EBWBImage2 [C:\Program Files [<BE)\E ur
EB'w/Blmage2Roif [Qig<=834, Drgr'=7|

< >

Orgr ‘Width  Height

Oigi

| | New | Fiemave |
= |
| Ol

3. Select the image in the tree.
4. Click on the New button.
5. In the dialog box, enter a Variable name for the new ROI.

The ROl is represented as a color rectangle on your image as illustrated below.
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Image Script Easylmage EasyColor EssyObject EasyGauge EasyMatch EasyFind EasyOCR EasyOCR2 EasyOCV  EasyBarCode de EasyQRCode Help
Roi Management... — X BT 1M ool | R omop o | BE R R B S
= EEWHmage2 (C:\Program Files (<66 Eur 3 T \ : el =
EBWEImage2Raid (0igH=834, Orar=7| H ; . T o -
EWBIalEZ'R
< >
0ROV Widh Height
ETN S S B =TS
e [P ] |
[A Draw Rois |
Cloze
7 = oo
}
Oper Read Execution time 141 millsec. Rz [¥[ 188 [Wodw] i Giap 158 Ih
EBWSEImage2 (C:\Program Files (xB6)\Euresys\Open eVision 2.2\Sample Images\EasyQRCode\QRCode 3.bmp) NUM Thu, 02 November 2017 1414

6. Drag the ROI corner and side handles to move it to the required position.
7. Click on the Close button to close the ROl Management window .

The next step is "Step 4: Configuring the Tool" on the next page.

Managing ROIs

You can add, change and remove ROls.

TIP

An image can have several ROIs. Each ROI can be attached directly to the
image (meaning that its position is relative to the image) or to another ROI
(meaning that its position is relative to this 'parent' ROI).

1. To manage ROls, go to the main menu: Image > ROl Management....
The ROl Management window is displayed with the ROl relation tree as illustrated below.

If the Draw Rois box is checked, all ROIs are displayed on the image with a different color.
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Image Script Easylmage EasyColor EasyO asyGsuge EstyMatch EasyFind EasyOCR  EssyOCR? EasyOCV EssyBarCode EasyMatrixCode EasyQRCode View Window  Hel
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1 EBWEImagez IC. \Frogiam Files [+GE1E urg
- EBw! o
Irc
rg
) EBWSImage2Flail 2 [Org=152 Orgr=
EBW/image2Rior 3 [Dgk=157. g
< >
Ot O Widh  Height
EENSIEE S =TS ‘
‘ Mew Remave
|
[A Draw Rois |
7 pticn handling o
}
Oper Read Execution lime 141 | millsec R[4 [Y [ |2 [w a8 i Gray 3 Jehi
EBWBImage2 (C:\Pragram Files (x86)\Euresys\Open eVision 2,215ample Images\EasyORCode\ORCode 3.bmp) NUM Thu, D2 November 2017 14:14

2. Select an ROl in the ROI relation tree.

3. Drag the ROI corner and side handles to change the position and size of the selected ROI (as
well as the position of all ROIs attached to it if any).

4. Click on the New button to add a new ROI attached to the selected ROI.

TIP

Select the image at the top of the ROI relation tree to attach the ROI directly
to the image.

5. Click on the Remove button to delete the selected ROI (and all ROIs attached to it if any).

6. Click on the Close button to close the ROl Management window.

3.4. Step 4: Configuring the Tool

Once your image, including its ROIs if you created some, is ready, you need to configure your
tool.

In the tool window:

1. Open the various tabs.

TIP
When you create a new tool, all parameters are set with their default value.
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[i | EQRCode (EQRCode) = *
Read Advanced

Detection Method
Adaptive Threshold
[

Perspective Legacy

Gradiert Legacy

Configuration

i Vesin
T——

Minimum Isotropy 0.75

Minimum Score 0.7

Cel Corfidence Threshoid [0 |
Perspecive Mode Basic -
Foreground Threshold

Timeout

Timeaut fms)

Example of the parameter tab of an EasyQRCode tool

2. In each tab, set the value of the parameters as desired.

Please refer to the "Functional Guide" and to the "Reference Manual" for detailed information
about the parameters, their function and their default value.

For specific actions such as learning or using gauges, please refer to the "Functional Guide".

3. Run the tool and analyze the results as described in the next step "Step 5: Running the Tool
and Checking Execution Time" below.

3.5. Step 5: Running the Tool and
Checking Execution Time

Once your tool parameters are set, run your tool and, if desired, check the execution time on
your computer.

In the tool window:

1. Click on the Read, Detect, Results or Execute button (depending on the library function), to
run the tool on the selected image.

2. Check the results on the image and in the Results field or area as illustrated below.
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Example of results after reading a QRCode

[i | EQRCode (EQRCoded)
Read  Advanced

Source Image

Results

S

EBWSImage 1 |

Detection Trade Off
[

Speed Balanced Reliabiliy
Custom Trade OF [
Unreliable QRCode

Show O

Message

EQRCode 1

Stream Parts __Parl 3 v
Diplay As

3.182,76.53,55.88,53.57
.43,50,52 50

Iz Reliable
Mode! Model 2/2005
Version | Version 2
Level  |Levell
Unused Eror Comection
Coding  |Basic

Application Indicator

1

n'a

 Fead

| [ Cose

3. If you do not have the expected results:

O Try to change your parameters (start with default values then change one parameter at a

time).

o If you image is not good enough, try to enhance it as described in .

4. Check the execution time in the execution time bar at the bottom left of the main Open
eVision Studio window.

| FOPSESRNNGT L. T I L i

_i Oper, |

Flead | Evecutontme | 113 | milisec |||T W (Y[ mE Wl

EBWEImage] (C:\Program Files (x6)\Euresys\Open eVision 2.2\Sample Images\EasyQRCode\QRCode 6.bmp)

The execution time

@ TIP

The execution time is the actual time that the processing took as measured

on your computer. It depends your computer processor, memory, operating
system... and, of course, on the processor load at the time of execution. Thus

this execution time slightly varies from execution to execution.

To get a more representative execution time, click on the Read, Detect, Results or Execute

button several times and calculate the mean execution time.

If your application requires that you reduce the execution time, try:

0 To change the tool parameters,

o To add one or several ROIs on your image,

o To enhance your image.




Open eVision Getting Started PART Il Open eVision Studio for Library y
Evaluation  ermEERIE

The next step is "Step 6: Using the Generated Code" below.

3.6. Step 6: Using the Generated Code

By default, Open eVision Studio translates all the operations you perform in the interface into
code in the language you selected as illustrated below.

Ee =er=]

/¢ This section contains the variable declarations

#include "Open_eVision_Z_:
using namespace Euresys::Open_eVision Z_2;

using namespace std;

EQRCodeReader EQRCodel;
vector<Egacode> EQACode
EImageBWs EBWSTmagel; /
‘ERQIBHS EBWSImagelRoil; // EROIEWS instance

// This section contains the cperations code

Ty

{
EBWETmagel Load("C

e¥ision I 2\\Sample
EQRCodel . SetTimeOut (5000) ;
EQRCodel . SetSearchField (EBWSImagel);
EQRCodelResuls = ZQRCodel Read();

/4 Bttach th

EBWSTmagel

_Attach(EEBWSTmagel) ;
EQRCodel . SetSearchField (EBWSImagel);
EQRCodelResuls = ZQRCodel Read();

1

catch(const EExceptions)

1

#/ Insert exception handling code here

1

Once your tool results suit you, you can save or copy this generated code to use it in your own
application.

Copy and paste the code in your application

In the script window:
1. Select the code section you want to copy.
2. Right click on this code and click Copy in the menu.

3. Go to you development environment tool and paste the code in place.

Save the code

1. Go to the Script menu.
2. Click on Save Script As....

3. Enter a file name and path to save the code as a text file.

Manage the generated code

In the Script menu, you can:

0 Select the programming language (please note that if you change the language, the script
window content is automatically deleted).

o Activate or deactivate the Script Code Generation. Deactivate this option if you want to
perform some operations without saving them as code.
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4 Pre-Process
Images

ng and Saving

When should you pre-process your images?

Of course, the best situation is to set up your image acquisition system to have good and easy to
process images so the Open eVision tools run smoothly and efficiently.

If this is not possible or easy to achieve, you can pre-process your images or your ROIs to
enhance and prepare them for the Open eVision tool you want to run.

Using the various available functions, you can adjust the gain and offset of your image, apply a
convolution, threshold, scale, rotate and white balance your image, enhance contours... using
Easylmage and EasyColor functions.

Pre-processing images

The difference between pre-processing an image and running tools is that the pre-processing
generates a new image while the tools mainly extract and retrieve information from the image
without changing it.

To pre-process an image or an ROI:
1. In the main menu bar, click on the library you want to use (Easylmage or EasyColor).
2. Click on the function you want to use.

Most function dialog boxes are similar to the one illustrated below with 2 image selection areas
and a parameter setting area.

[ Threshold =

X

Simple Threshold  Double Threshold  Adaptive Threshold

Source Image Destination Image O Absolute B r
(O Relative =
(®) Minimum residus
(O Maximum entropy
i O lso-data
8
[ Preview Mode
= Rbove or onthreshold =
i 51 =]
(® White () Reddish () Gray
[EBWekmage 1 ||| [EBWBImages [ || [Botow theestiid
T —— @Black O Bhish ) Gray
G

Example of a pre-processing dialog box (Threshold with Easylmage)
3. If there are multiple versions for your selected function, open the corresponding tab.

4. In the Source Image area, open the source image (as described in "Step 2: Opening an Image"
on page 25).
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5. In the Destination Image area, open or create a new destination image.
6. Set your parameters.
7. Click on the Execute button.
The pre-processed image is available in the destination image as illustrated below.

@ Open eVision Studio - EBWBImage1 (C:\Program Files (xB6)\Euresys\Open eVision 2.2\Sample Images\EasyQRCode\QRCode 5.bmp) - m} x

Image Script Easylmage EasyColor EasyObject EasyGauge EasyMatch EasyFind EasyOCR EasyOCRI EasyOCV EasyBarCode EasyMatriCode EasyQRCode View Window Help

B @B W[ Q[ o 28T i w27 O BR | oce o oo | R B | =

3 mage! (CAProgram Files (x36)\Euresys\Open eVision 2.2\Sample [mages\EssyORCode\.., [-=- | = [[5a] | 2 0 o :
=

| [Oper | Eaimage:Thieshold | Eweculontme | 1912 | milleec ||[?'[ 2 [v[ 5w [Wald® | Gray 255 lsh =]

EBWSImage5 NUM Wed, 15 November 2017 08:54

Source and destinations images (Threshold with Easylmage)

8. If you want to use the destination image outside of Open eVision Studio, save it as described
below.

Saving an image

1. Click in the image you want to save to activate it.
2. To open the save menu either:

O Right-click in the image

o Or open the main menu > Image

Click on Save as....

Select the file format (JPEG, JPEG2000, PNG, TIFF or Bitmap).

Enter a name and select a path.

o u A~ W

Click on the Save button.
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1. Start the Application and Open

a Project

1. Launch Easy3D Studio.

The following screen is displayed:

£ EURESYS Easy 30 Start

Streams

2. Select your stream in the list of the available streams displayed in the Select Stream area.
3. Open your project (. json file):
o Click on Create Project to create a new project.

o Click on Load Project to open an existing project.
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The main screen is displayed as illustrated:

£ ZURESYS

File View GenlCam Help

Profile DepthMap PaintCloud

I

(]

Easy 3D Start

LinearFilterCoefficie 1

| LinearFilterCoefficie 1

| LinearFilterCoefficie 1

NoiseControl True

. ROIControl |False

. Width 0

ExtractionMethod
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2. Configure the Acquisition RO

1. Open the Profile tab.

2. Click on the 0 run button to start free-running acquisition.

3. Place your caliber or your object under the laser line.

TIP

To optimize the computation time, make sure the laser line illuminates the
lowest as well as the highest areas of the object.
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4. In the Profile window, move and resize the ROI (the green rectangle) to fit and enclose the
laser line image.

TIP
With a smaller the ROI, the extraction computation is faster and the
resolution is better.

5. In the parameter list, select the ExtractionMethod to use to compute the laser line
extraction.

TIP
Do not use MaxDetection 8 if your ROI height is larger than 256 as this
would introduce a saturation effect in the extraction result.

6. Once the setup is complete, click on the 0 pause button to stop the acquisition.
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3. Calibrate the Setup

1. Open the DepthMap tab.

2. Place your caliber on your system.

3. Click on the 0 run button to start an acquisition.

4. Move the caliber under the camera and wait for the image acquisition to complete.
5. Once the acquisition is displayed, click on the 0 pause button to stop the acquisition.

£ EURESYS
File niCam el
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6. Open the PointCloud tab.

Easy 3D Start

)
C EURESYS
File View GenlCam Help

Prafile DepthMap

Elal | @ calibite
4 CalibrationMethod

# CalibrationModel

ScaleFactorX 1
ScaleFactorY 1
ScaleFactorZ 1

CalibrationMethod

7. Use the mouse on the image to freely move it around in 3D.

£ ZURESYS Eosy 3D Start

File View GenlCam Help

Prafile DepthMap

‘CalibrationMethed | ScaleMethod

L EURESYS

ObjectScale

PassesCount 1

CalibrationMethod

ObijectType TruncatedDoubleSquarePy

PrecisionVsSpeedT Balanced
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8. In the parameter list:

O SetcCalibrationMethod to ObjectBasedMethod.

o Select the objecttype corresponding to your caliber.
9. Click on the Calibrate button.

After some processing, the calibrated image point cloud is displayed.

Easy 3D Start

Prafile DepthMap

Elal | @ calibite
CalibrationMethod | Object3

4 CalibrationModel
ObjectScale 1
ObijectType TruncatedDoubleSquarePy
PassesCount 1
PrecisionVsSpeedT Balanced

CalibrationMethod
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4. Acquire a Depth Map

1. Open the DepthMap tab.

2. Place your object on your system.

3. Click on the 0 run button to start an acquisition.

4. Move the object under the camera and wait for the image acquisition to complete.

5. Once the acquisition is displayed, click on the 0 pause button to stop the acquisition.

The "raw" image of your object is displayed.
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6. Open the PointCloud tab.

The calibration correction is applied to the image before display.

£ EURESYS Easy 3D Start

File View GenlCam Help

Prafile DepthMap

2| @ colibte
T .

L EURESYS

ObjectScale
ObjectType
PassesCount

am  Help

Deptildap

CalibrationMethod

ObjectB

- CaBbianadd
1
TruncatedDoubleSquarePy

1

PrecisionVsSpeedT Balanced

2| B cotboe
2 CalibrationMethod

Method

ObjectBasediethod
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8. Open the ZMap tab.

The corresponding ZMap is generated and displayed.

9. Configure the ZMap view:
0 Select the projection axis of the image: set the ReferencePlaneMode as X, Y or Z-plane.
0 Along the selected axis, set the offset of the displayed image.

10.Click on the Compute button to apply your changes and display the new image.
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5. Export a ZMap

1. Open the File menu.
2. Click on Export ZMap.
3. Select the type of file you want to create:
o PNG
o TIFF
o BMP (Bitmap)
4. Enter the file name.
5. Click on the Save button.
You can also save a profile, a depth map or a point cloud the same way.
The available file formats are:
o Profile: PNG, TIFF, Bitmap
o Depth map: PNG, TIFF, Bitmap
o Point cloud: PCD
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6. Add or Remove Parameters

The parameters listed in the different tabs are the basic software parameters that you need to
control and adjust to use Easy3D Studio.

In the Profile and in the DepthMap tabs, you can add some hardware parameters (related to the
frame grabber or to the camera) that you want to quickly and easily display or control:

1. Open the GenlCam menu.
2. Click on GenlCam.

The GenlCam window opens as illustrated.
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3. To show or hide a parameter, click on the 'eye' icon:
0 Left 42 : the parameter is hidden in the Profile tab.
O Right *: the parameter is hidden in the DepthMap tab.
0 Left €. the parameter is displayed in the Profile tab.
O Right €©»: the parameter is displayed in the Profile tab.

TIP
The changes are automatically and immediately applied in the Easy3D Studio
main window.

4. Close the GenlCam window .

5. To save the your changes, open the File menu and click Save Project.
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